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								bob_sun
							

							User
	Posts: 166
	Joined: Sat Jan 22, 2011 9:11 am



		
						

						
						*Editor wish list*
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by bob_sun » Sat May 10, 2014 7:55 pm
			

			
			
			
			I would also like to add two to wish list:



1. Allow editor automatically start in multiple instance (like viewer)

2. When opening multiple documents in one instance, the thumbnail preview cannot be used. Please fix it.

3. The current “proximity” options are superb comparing with other PDF readers, this is a big attraction. Could tracker add regular expression (Boost library’s Perl style) support or at least wildcard (?*) to search? 





Bob
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						Re: *Editor wish list*
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						Post
					
								by PeterPan » Sun May 11, 2014 9:42 pm
			

			
			
			
			Hi,



1. is already possible: Open two documents and then drag & drop one document outside the editor.



Best regards
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						Re: *Editor wish list*
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						Post
					
								by John - Tracker Supp » Mon May 12, 2014 4:12 pm
			

			
			
			
			Thanks Peter [image: :)]


			
			
									
													If posting files to this forum - you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded - thank you.



Best regards

Tracker Support

http://www.tracker-software.com
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			Hi bob_sun,



Thanks for the post - I'll answer each point in turn:



1) While PeterPan's suggestion is currently the only way to do this, the next build (308) has the ability to select the option to allow Multiple Frames, similar to the way that the Viewer did.



2) This is working fine for us here and I've not heard this reported before. Please keep in mind that the Thumbnails Pane must be enabled/disabled on a per document basis, unless this is set as the default view. If that's not the issue, then please make sure that you are using the latest build by downloading and running the following installer:

https://www.pdf-xchange.com/PDFXVE3.zip



3) I believe that this is something that we're looking at implementing, but I would have to double check that with the Development team. If there's not already a feature request in, I will place one.



Cheers,


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
			
						


		


				
						
				
				Top
			
					

		
		

	


				
		

			
				


																			

								bob_sun
							

							User
	Posts: 166
	Joined: Sat Jan 22, 2011 9:11 am



		
						

						
						Re: *Editor wish list*
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by bob_sun » Tue May 13, 2014 11:48 am
			

			
			
			
			Hello,



Could you confirm if regular expression search has been added in this week's release?


	Additionally, could you give me some general informaiton about Tracker's SDK:

Who use them?

If programmers can implement any function with these SDK, then can they make their own builds themselves? Can they build their customized needed functions without depending on Tracker?

What is the developing environment (IDE)? Does Tracker provide those codes in source code or DLL/LIB mode?



I do not want to write PDF readers myself. Just being impatient.



Bob
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								by Will - Tracker Supp » Tue May 13, 2014 4:39 pm
			

			
			
			
			Hi bob_sun,



It's not been added to this coming release, but it's something that the Devs. feel they can implement for a later release.



As far as using the SDK goes, it's limited to what our libraries allow and the features that are implemented in it. For the most part, this is the same as the End User version, though the SDK's obviously do allow for some extended functionality, provided that user's know how to access said functionality. Search by Regular Expression hasn't yet made it into any of the SDK's either.



Hope that helps!


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			Hi,

Any word on the drag and drop between two open pdf's feature request?

Thank you!



Larry
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								by Paul - Tracker Supp » Tue Oct 28, 2014 7:56 pm
			

			
			
			
			Hi Larry,



you should already be able to drag and drop between frames as long as there are no security restrictions in the document itself.  You ca:



1. Drag thumbnails from Thumbnail Pane to Thumbnail pane and position it at any location in the document.

2. Drag supported file types from Explorer (images for example) to the thumbnails pane at a location of your choice and a new page with the image content will be added to the document

3. Drag support file types from Explorer to the Editor main window and a new document will be opened with that content.



hth
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Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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						Re: *Editor wish list*
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			Paul - Tracker Supp wrote:Hi Larry,



you should already be able to drag and drop between frames as long as there are no security restrictions in the document itself.  You ca:



1. Drag thumbnails from Thumbnail Pane to Thumbnail pane and position it at any location in the document.

2. Drag supported file types from Explorer (images for example) to the thumbnails pane at a location of your choice and a new page with the image content will be added to the document

3. Drag support file types from Explorer to the Editor main window and a new document will be opened with that content.



hth





Hi Paul,

Ah, nice!  Does that mean the feature request no longer on the table?  I've been spoiled by the old eCopy Desktop 9.2 software, which let you visually drag n drop a page from one open pdf frame to another open pdf frame (side by side or over and under).

Thank you!



Larry
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			Hi Larry,



sorry about that, I guess I wasn't terribly clear.  When I said
1. Drag thumbnails from Thumbnail Pane to Thumbnail pane and position it at any location in the document.


I should have said in the same or another open document/frame.  Having said that now I think that this is the same as:
 visually drag n drop a page from one open pdf frame to another open pdf frame (side by side or over and under).



The thumbnail pane has a thumbnail of each page in a PDF.  You can visually drag a selection of pages from one open document to another.  It will insert the pages into the target frame/document but not remove them from the source.  Perhaps that's what you are looking for?



I hope I haven't missed the point here.



regards


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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			Paul - Tracker Supp wrote:Hi Larry,



sorry about that, I guess I wasn't terribly clear.  When I said
1. Drag thumbnails from Thumbnail Pane to Thumbnail pane and position it at any location in the document.


I should have said in the same or another open document/frame.  Having said that now I think that this is the same as:
 visually drag n drop a page from one open pdf frame to another open pdf frame (side by side or over and under).



The thumbnail pane has a thumbnail of each page in a PDF.  You can visually drag a selection of pages from one open document to another.  It will insert the pages into the target frame/document but not remove them from the source.  Perhaps that's what you are looking for?



I hope I haven't missed the point here.



regards



Hi Paul,

I fully understood what you said and was able to perform it as you described.  I should have been more clear. 

What the old eCopy does is allow you to see multiple thumbnail views at the same time and drag n drop between them. Would that be possible?

Here is a screenshot of what I mean: http://snag.gy/xkHU9.jpg

Thank you for your replies!



Larry
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								by Paul - Tracker Supp » Thu Oct 30, 2014 10:42 pm
			

			
			
			
			Hi Larry,



you can arrange the various windows in the editor to do effectively that.  Do either of these layouts work for you?



[image: Image]





and





[image: Image]



BTW, those are thumbnails, I just created some new documents with blank pages and numbered them.  In both cases I opened the Thumbnail tabs and dragged them to fill the entire window obscuring the main document window.



I think that is what you are looking for, you can drag and drop between documents this way, hold the shift key when dragging to move otherwise it copies pages.



hth
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Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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								by lknowlton » Fri Oct 31, 2014 2:33 pm
			

			
			
			
			Paul - Tracker Supp wrote:Hi Larry,



you can arrange the various windows in the editor to do effectively that.  Do either of these layouts work for you?






Yes the second one especially, but I'm not sure how you got them side by side like that.


			
			
									
																
						


		


				
						
				
				Top
			
					

		
		

	


				
		

			
				


																[image: User avatar]														

								Tracker Supp-Stefan
							

							Site Admin
	Posts: 17853
	Joined: Mon Jan 12, 2009 8:07 am
	Location: London
	
				Contact:
				
					
						Contact Tracker Supp-Stefan
					
					
						


						
																																								
																	
										Website									
																	

																					

					

				

			



		
						

						
						Re: *Editor wish list*
		


														
							
								Quote
							
						


							
						
									
						Post
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			Hi Larry,



Click on a tab and then go to Window -> Active tab to a new vertical/horizontal group.



Regards,

Stefan
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								by lknowlton » Fri Oct 31, 2014 4:49 pm
			

			
			
			
			Tracker Supp-Stefan wrote:Hi Larry,



Click on a tab and then go to Window -> Active tab to a new vertical/horizontal group.



Regards,

Stefan



Nice!  That's perfect!  You all are on top of the list of software to replace our old eCopy!

Thank you!



Larry


			
			
									
																
						


		


				
						
				
				Top
			
					

		
		

	


				
		

			
				


																[image: User avatar]														

								Paul - Tracker Supp
							

							Site Admin
	Posts: 6869
	Joined: Wed Mar 25, 2009 10:37 pm
	Location: Chemainus, Canada
	
				Contact:
				
					
						Contact Paul - Tracker Supp
					
					
						


						
																																								
																	
										ICQ									
																																																
										Website									
																	

																					

					

				

			



		
						

						
						Re: *Editor wish list*
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by Paul - Tracker Supp » Fri Oct 31, 2014 7:55 pm
			

			
			
			
			[image: :D]


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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								by lknowlton » Thu Nov 06, 2014 2:21 pm
			

			
			
			
			Hi Guys,

One other thing our old software can do is create stamps from within the software.  Within an open pdf, click and drag a selection box around something (ie a handwritten signature) and make it a stamp. Please see the image at http://snag.gy/FxT0A.jpg for a better idea of what I mean.  I know images can be imported and all, but it sure is a handy feature to be able to create a stamp within the program!  Could this be added or is it already possible?  



On the wouldn't it be a really really cool thing wish list: Could this feature be made to create transparent stamps (gifs), so that the PDF in the background is fully visible behind the stamp?  



Thank you!



Larry
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			Hi Larry,



While not a 1 but 2 step process - you can do the same with the Viewer/Editor.

Select the snapshot tool, and select the area you want to make a stamp from. Then go to the stamps palette and click the "New from Clipboard..." option.



Regards,

Stefan
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						Re: *Editor wish list*
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						Post
					
								by lknowlton » Thu Nov 06, 2014 4:24 pm
			

			
			
			
			Tracker Supp-Stefan wrote:Hi Larry,



While not a 1 but 2 step process - you can do the same with the Viewer/Editor.

Select the snapshot tool, and select the area you want to make a stamp from. Then go to the stamps palette and click the "New from Clipboard..." option.



Regards,

Stefan



Hi Stefan,

I tried your steps, but From Clipboard is grayed out.  Am I missing something?  I went into paint and pasted it, so it is on the clipboard. This was in the Viewer.  The Editor stamp palette worked with the clipboard icon.

Thank you!



Larry
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			Hi Larry,



Please make sure that you are using the latest build by downloading and running the following installer here:

https://www.pdf-xchange.com/PDFXVE5.zip



Cheers,


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			Will - Tracker Supp wrote:Hi Larry,



Please make sure that you are using the latest build by downloading and running the following installer here:

https://www.pdf-xchange.com/PDFXVE5.zip



Cheers,



Ah, installing the latest viewer fixed the grayed out From Clipboard issue!  So, create stamp fuctionality from within has been answered as well!  Awesome!

Thank you all!



Larry
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													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			I am still waiting for the feature "search with wileddcards"... (version 7.0 Build 325.1)
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			Hello winkelmann,



Thanks for bringing this up! I am afraid that for the moment this feature is not yet available, but I will check with our devs where in the ToDo list it is!



Cheers,

Stefan
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			Thanks. Hope there you'll find it...
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			Classic view...



as in back to the v6.x style view rather than the current MS office ribbon clone which adds 4 clicks to switch between the tools i use the most instead of 1!

 (i now have to go from Home tab, to comment tab, select the comment type i need, then go to the commenting format tab then back to home, over and over again!)

before our IT department forced the update i could get to everything i needed from the main view, with the appropriate formatting commands popping up under the main toolbar as soon as i selected a tool.



please please bring this window layout back (as a switchable option would be fine) as the new version is so much worse for efficiency
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			Never mind, ive just found the button to change it and its much better now
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			Hello Dasy,



Glad to hear you found it!

Enjoy using our products!



Cheers,

Stefan


			
			
									
																
						


		


				
						
				
				Top
			
					

		
		

	


	

	
	
			
							Post Reply 
					
		
		
		
			
			
		
		
			


				
					
						Print view
					
				


		

	


			
		
	
		
		
	
	
		


		
			
							Display: All posts
1 day
7 days
2 weeks
1 month
3 months
6 months
1 year


								Sort by: Author
Post time
Subject


				Direction: Ascending
Descending


								

				
						

		

	



		

	
	
	
			
			29 posts
							• Page 1 of 1
					

	





		
		
			Return to “PDF-XChange Editor”
		
	

	
		
			
				Jump to
				
			
		
			


				  Support
	 ↳   Welcome to Tracker Software Support Forums - Forum Rules & Regs
	  End User Forums - Current Releases
	 ↳   FAQ- Frequently Asked Questions (End Users)
	 ↳   PDF-XChange Editor
	 ↳   Editor plugins
	 ↳   OCR- For the PDF-XChange Editor and Viewer
	 ↳   PDF-Tools
	 ↳   Touchscreen Devices
	 ↳   PDF-XChange Print Drivers
	 ↳   PDF-XChange Viewer (End Users)
	 ↳   Office2PDF & MS Office Addin
	 ↳   How to forum
	 ↳   Network Administrator Support
	 ↳   Editor Videos
	  Software Developer Forums
	 ↳   PDF-X OCR SDK
	 ↳   PDF-XChange Editor SDK
	 ↳   PDF-XChange Core API SDK
	 ↳   PDF-Tools SDK (all our PDF DLL Libraries)
	 ↳   PDF-XChange Drivers API SDK
	 ↳   PDF-XChange Viewer SDK
	 ↳   PDF-XChange Translators
	  New Features Requests (End Users)
	 ↳   PDF-XChange (End Users FR)
	 ↳   PDF-Tools (End Users FR)


		

	


	










			




		All times are UTC
	
		Home				Board index
				







	

	

		
		
				
			Powered by phpBB® Forum Software © phpBB Limited
		

				        phpBB 3 Quarto theme by PixelGoose Studio

		
			
				Privacy
			
			|
			
				Terms
			
		

			


	
		 

	


	
		
			
		
		 


	

	
		
			
		
		

	




		Delete cookies
	Contact us








	
	



























			
			    
				
					
						
							Username: 

						


						
							Password: 

						





						
							
							



							
															 Remember me
													

					

				

								        
													Register
															        


			

			

